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CHAPTER ONE: INTRODUCTION

1.1 Background

A flood is an overflow of an expanse resulting into submerging of surrounding expanse of land.
Rivers and other water bodies are prone to overflow as water escapes its usual boundaries.
However, these floods are very devastating both to human life and structures on the earth’s
surface like bridges, homes, roadways e.t.c. yet at the same time the aftermath of floods can
dwindle the economy since various sectors are affected e.g. tourism, construction industry,
agricultural sector resulting into food shortages thus high prices due to high demand and all
secondary effects that occur. It’s for these reasons that Governments, research organizations and
universities consider assessment of the risk of flooding important.

Traditionally, flood hydrology has concentrated on design parameters which are important for
structures but the methods do not necessarily allow for cost effective production of flood risk
maps for large areas such as district municipalities (Botes et al, 2012). Today, GIS is powerful
tool in water resources like flood risk assessment and mapping at various scales. Hydrologists
use GIS technology to integrate various data and applications into one, manageable system
(ESRI, online).

Flood prediction and modeling refers to the processes of transformation of rainfall into a flood
hydrograph and to the translation of that hydrograph throughout a watershed or any other
hydrologic system. Flood prediction and modeling generally involve approximate descriptions of
the rainfall-runoff transformation processes. These descriptions are based on either empirical, or
physically-based, or combined conceptual physically- based descriptions of the physical
processes involved. Although, in general, the conceptualizations may neglect or simplify some of
the underlying hydrologic transport processes, the resulting models are quite useful in practice
because they are simple and provide adequate estimates of flood hydrographs (Ramirez., 2000).

The hydro data model together with Geo HEC-HMS are some of the powerful GIS tools used to
model flood hazards. The hydro data model is majorly a Geodatabase with for water resources
applications, and consists of a set of tools to perform analysis, support Geodatabase design and
basic water resource functions. The Hec-GeoHMS is an arcGIS10 extension that enables us to
create a basin model which is later imported to HEC HMS for calibration and hydrological
modeling while the HEC RAS provides models for hydraulic modeling.

1.2 Hydrological Modeling

In natural hydrological system water that falls as precipitation returns to the atmosphere though
transpiration from vegetation. Some precipitation falls on vegetation through leaves or runs
down the stem, branches to the land surface, where it joins the precipitation that fell directly onto
the surface (HEC HMS, chapter 3). Depending on the land cover/land use, soil type; water may
infiltrate, and water that doesn’t infiltrate moves by overland flow. Thus the stream channel is a
combination of point of overland flow, the precipitation that falls directly on water bodies in the
watershed and interflow and base flow leading to total watershed outflow.
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Figure 1.1: The Hyrological Cycle: the Circulation of Water on the Earth

All land in watershed can be categorized as either directly connected impervious surface or
impervious surface. Impervious areas can be defined as areas in which all rainfall is converted to
surface runoff, and are categorized into buildings (e.g. roof surfaces) and transportation
infrastructure (e.g. roads, driveways, parking lots, etc.) (Schueler, 1994). Rainfall on pervious
surfaces is subject to losses.

Various models have been developed to model precipitation and consequently runoff. Some of
these models include: The initial and constant rate loss model, the deficit and constant rate
model, the SCS curve number (CN) loss model to name but a few!

1.2.1 The SCS Curve Number Loss Model

This model has proven to be a very useful tool for evaluating effects of changes in land use and
treatment on surface runoff (Sorrell, 2010). The soil conservation service SCS Curve number
(CN) model estimates precipitation excess as a function of cumulative precipitation, soil cover,
land use and antecedent moisture.

2
(P—ag)
P, _p-1,+s

Where;

P, is accumulated precipitation at a time t/runoff



P = accumulated rainfall depth at time t

I_ = the initial abstraction(initial loss )

§ = the potential maximum rentation—

ameasure of the watershed to abstract and retain storm precipitation.

Until the accumulated rainfall exceeds the initial abstraction, the precipitation access, and hence
the runoff will be zero

I, =025

Therefore the cumulative excess time t is

(P-0.25)2
Pu = P+0.8s3

Incremental excess for a time interval is computed as the difference between the accumulated
excess at the end of and at the beginning of the period.

The maximum rentation, S, and watershed characteristics are related through an intermediate
parameter, the curve Number
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The CN values range from 100 to approximately 30 for permeable soils with high infiltration
rates. For watershed that consist a several soil types and land uses, a composite CN is computed

_ T ACN,

CNcnmpnsite - zﬁl
i

Where: i is the index of the watershed subdivisions of uniform soil type and land use, Ai Is the
drainage area of the subdivision i

The curve number method was developed to span a broad set of conditions ranging from
heavily forested watersheds with steep channels and a high percent of the runoff resulting from
subsurface or inter-flow and meadows providing a high retardance to surface runoff, to smooth
land surfaces and large paved parking areas (National engineering handbook). It is essentially
a coefficient that reduces the total precipitation to runoff potential, after “losses” — Evaporation,
Absorption, Transpiration, and Surface Storage. Therefore the higher the CN value the higher the
runoff potential will be. To determine appropriate CN value, a table popularly known as a look
up table has to be supplied. The look-up table has value of CN for different combinations of land



use, land slope, land treatment, practice and impervious percentage and hydrological soil group
as shown in table 2.1

Table 2.1 Run Off curve numbers for hydrological soil cover complexes (AMC-II conditions)'

= logi rologic soil grou
Land use Treatment or practice :l::dilio; H);d ch g pD
Fallow soil Straight row 7 86 91 94
Straight row Poor 72 81 B8 91
Good 67 78 85 89
Poor 70 79 B84 88
Row crops Contoured Good m 75 02 M
Poor 66 74 80 82
Contoured and terraced Good @2 T 78 al
Straight row Poor 65 76 84 &8
Good 63 75 83 87
. Poor 63 74 82 85
Small grain Contoured Good 81 73 a1 m
Poor 61 72 79 82
Contoured and terraced Good %9 70 78 B
. Poor =5 77 85 89
Straight row Good 58 | 72 | 81 | 85
Closgseeded legumes or Contoured Poor 64 75 83 85
rotation meadow Good 55 69 78 83
Poor 63 73 B0 83
Contoured and terraced Good 7 &7 76 0
Poor 68 79 86 89
Fair 449 B9 79 B4
= Good 39 61 74 80
asture or range Poor 27 | 67 | 81 | s
Contoured Fair 30 59 75 83
Good 30 35 70 79
Meadow 30 58 7 78
Poor 45 66 77 83
Woods Fair 36 B0 73 79
Good 30 55 70 7
1% acre 77 B85 a0 92
V4 acre 61 75 83 87
Residential 1/3 acre 57 72 81 86
1% acre 54 70 80 B85
1 acre 51 68 79 84
Open spaces (parks, golf Good condition: Grass cover > 75% of area 39 61 74 80
cOourses, © teries, etc.) Fair condition: Grass cover 50-75% of area 49 ] 79 84
Comrr]efcual or business area 89 02 o4 o5
(85% impervious)
!ndu strfal district (72% 81 8 01 03
impervious)
Farmsteads 59 74 82 86
Paved areas (roads, drive- o8 o8 o8 o8
ways, parking lots, roofs)
Water s_urfaces (lakes, ponds, 100 100 | 100 | 100
reservoirs, etc.)
S At least 1/3 is open water 85 85 85 85
wamp Vegetated 78 | 78 | 78 | 78

Source: Sorrelli P.E., 2010

From the table above it can be observed that built up areas have generally high curve numbers

1 A. Soils having high infiltration rates even when thoroughly wetted and consisting chiefly of deep, well to excessively drained sands or gravels.
These soils have a high rate of water transmission.

B. Soils having moderate infiltration rates when thoroughly wetted and consisting of moderately deep to deep, moderately well to well drained
soils with moderately fine to moderately coarse textures. These soils have a moderate rate of water transmission.

C. Soils having slow infiltration rates when thoroughly wetted and consisting chiefly of soils with a layer that impedes the downward movement
of water or soils with moderately fine to fine texture. These soils have a slow rate of water transmission.

D. Soils having very slow infiltration rates when thoroughly wetted and consisting chiefly of clay soils with a high swelling potential, soils with a permanent high water table, soils

with a claypan or clay layer at or near the surface, and shallow soils over nearly impervious material. These soils have a very slow rate of water



(CN) for all hydrological soil types as compared to agricultural areas implying a higher runoft in
urban land uses.

1.2.2 Hydrograph Simulations Using SCS Model

One of the characteristic values in rainfall-runoff modeling is the retention of the system or lag
time, which is defined as the time elapsed between the centroids of effective rainfall and the
direct runoff hydrograph (Kazimierz, 2010). Both lag and time of concentration are made up of
travel times which are used for flood routing and hydrograph construction (National Engineering
handbook 4).

The Tc is most often defined as the time required for a particle of water to travel from the most
hydrologically remote point in the watershed to the point of collection. There are several
methods available for calculating Tc, one of which is the Lag Method:

L I".8 (S+1)~.7
Tc=--- where L=-----mmmmmmmm-
.6 1900 Y~.5
1000
and S=------- - 10
CN

Tc=Time of concentration [hours]
L=Lag time [hours]
I=Hydraulic length of watershed [feet]
Y=Average land slope [percent]
S=Potential maximum retention [inches]
CN=Weighed Curve Number

The hydrograph that results from 1-inch of excess precipitation (or runoff) spread uniformly in
space and time over a watershed for a given duration (Kazimierz, 2010: Rao et al., 1972). The
hydrograph is made dimensionless by expressing: Ordinates as a fraction of the peak discharge
qp, Time axis as a fraction of the time-to-peak T,. By analyzing a large amount of measured
data the SCS developed an average dimensionless unit hydrograph:

SC5 DIMENSIONLESS UNIT HYDROGRAPH

0 = Burali Durotion
q = Dachorge ot 1ime T
gp = Peak Dischorge
Tp = Time of peck
Te =5 D
Tp = 273 Tc

q /7 ap
=
M - R Bm@m - dagdm




Figure 1.2: SCS dimensionless Unit hydrograph



1.3 General Flood Methodology

Hydrological

and meterological data

Mulii- data Sattelite
Topographic Data/DEM imagery

slope, watersheds, drainage,
sub basins etc

Characterisation and
hydrological parameterisation

of sub basin

multidate Land

. use data
Sails Overlay and Analysis
meteorological data
Direct run off computation
Hydrological Data
flood forecasting
model
Observed Data madel calibration
and validation
final flood fore casting model
Multidate TIN/ alt DEM

Flood innudation and
simulation (RAS)

Figure 1.3: General flood modelling methodology (source:Prasad, 2007)
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1.4 Relationship Between GIS, Hydrological and Hydraulic Models

GIS Interface
dala models
N / 7
y, /
HIS o Hms |
/ ([u]¥]
— | |
Il—|
i S F. [ |'I
Geo
Database /
r Il'I /!
RAS ! mas |
IChA I.-' !
ey

Figure 1.2: Components of flood modelling system
1.5 Requirements and Description
Data
e Topography(contour or crossection data)/ DEM for study area,
e Multidate imagery for land use extraction
e Rainfall data (Rain guage data, rainfall frequency data etc)
e Soil data and impervious grid
Image processing software
e IDRISI, ERDAS, Envi, Ecognition etc
GIS Software:
e ARCGIS(Not Free), ArcHydro’(Free),
e HEC GeoHMS and HEC GeoRAS(free)’,
Modelling Software*:

e HEC HMS for hydrological modelling and HEC RAS for hydraulic modelling(free)

? http://support.esri.com/en/downloads/datamodel/detail/15
3 http://www.hec.usace.army.mil/software/
* http://www.hec.usace.army.mil/software/




CHAPTER TWO: IMAGE ANALYSIS

REMOTE SENSING (Data aquisition)
Data Aguisition --
Single scene
Multi-date Satellite data

Resampling, image

Image Preprocessing ; ;
Registration

s It
Land Use Classification
Software
. ¥ + ECognition
& |drisi
¥
' ™y & E\._J-I
Classified mult-date Accuracy Assessment e Erdasimagine
| Land Use Grids p—
b - .

Figure 2.1: Remote Sensing process flow
2.1 Data Aquisition

Georeferenced LandsatLook satellite images can be accessed freely from the new global landsat
viewer’ powered by esri geoserver courtesy of USGS for different time spans.

2.2 Image Preprocessing

Immage preprocessing is carried out using an image processing softwre of choice. After visual
analysis to confirm agreement of georeferenced images of region of interest are extracted. Image
restoration and transfomation are then carried out together with the the removal of systematic
noise due to bad scan data using Principle component analysis (PCA) as well as atmospheric
correction to remove haze.

2.3 Type of image analysis
Choice: Per pixel or object Oriented classification (depending on resolution of data)

2.4 Image Classification

5 Available from <http:/landsatlook.usgs.gov/>
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The first step in classification process is development of a classification scheme i.e FAO, USGS
LUC etc, and determination of appropriate bands for image processing. After determination of
appropriate bands classification is performed using a selected algorithm like maximum
likelihood classification, support vector machine, decision trees etc, is performed

2.5 Preprocessing of Training And Test Dataset

Training and test data is delineated based on the analysts's prior knowledge of the study area
(field vists, higher resolution imagery).

2.6 Results

land cover classification for different dates whose accuracy is assessed using a confusion matrix
to asses the accuracy with which the classification has been done

Disadvantages: downloading imagery requires higher band width when it comes to internet
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CHAPTER THREE: GIS PROCESSING

3.1 CREATION OF CN GRID

~ Landuse maps

% 4 i o £ B
..- - fa 2 £ b .!_
:.{:’ . ., . i ;
'-'-‘E’-\_L 2 ‘{4\ u ?__4"
Date f1 Date 2 Date n
Classified Multi-Date Soil Faatare class Hydro DEM
LandUse Grids

l h 4

Component table +

Convert to Polygon

soil feature class
Il Multi-Date
Curve Number Gridﬁ_

Soil land use
»

feature class {union)

Create CNLookUp
Table

Figure 3.1: Process flow for creation of CN GRID

3.2 DEM preparation

Fill sinks

This function fills the sinks in a grid. If cells with higher elevation surround a cell, the
water is trapped in that cell and cannot flow. The Fill Sinks function modifies the

elevation value to eliminate these problems.

71 On the ArcHydro Toolbar, select Terrain Preprocessing—>Data Manipulation 2Fill
Sinks.
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71 Confirm that the input for DEM is AgreeDEM (or your original DEM if
Reconditioning was not implemented). The output is the Hydro DEM layer, named by
default Fil. This default name can be overwritten.

@ Fill Sinks

DEM | Agree DEM

Deranged Polygon [Null

Hydro DEM Fil
[] Use IsSink Field

Fill Method
i Fill Thresheld (DEM Z-Unit) 10
i@ Fill All

J

Figure 3.2: Fill sinks

Press ok and the fill layer will be added into the map document
3.3 Preparing Land Use Data For CN Grid

Add the multi date land use grids to the map document. You will see the grid is added with a
unique symbology assigned to cells having identical numbers for an identical land use class as
shown below:

II:.IIIII[;I:.IIIIE
AABEI N AA =TS )

Date 1
15



Date 2 Date 3
Figure 3.3: Multidate land use Grias

Note the land uses are described according to the standard classification system applied during
image analysis e.g USGS land cover institute (LCI) , FAO etc. In case the land use grids have
many land use categories, you may reclassify them into major land uses to make the task much
easier. To implement reclassifictaion use spatial analyst->reclassify

The final step in processing land use data is converting the land use grid into a polygon feature
class which will be merged with soil data later. Click on Spatial Analyst->Convert--.Raster to
Features. Confirm the Input raster is lu reclass, the Field is Value, output geometry type is
Polygon, and save the Output features as landuse poly.shp.

3.4 Preparing Soil Data

Add soil feature class to the arc map document. This soil data could be derived from the national
soils database or FAO Database.

3.5 Merging Multi Date Landuse and Soil Data

To merge/union soil and landuse data, use the Union tool in ArcToolbox available under
Analysis Tools=>Overlay. Browse/drag cedar soil_clip and landuse poly as input features, name
the output feature class as “soil landuse” in the same geodatabase (CNSCS.mdb), leave the
default options, and click OK. Save the map document.

The result of union/merge features inherit attributes from both feature classes that are used as
input. However, if the outer boundaries of input feature classes do not match exactly, the
resulting merged feature class (cedar soil lu in this case) usually will have features that will
have attributes from only one feature class because the other feature do not exist in this area.
These features are usually referred to as “slivers”. If you open the attribute table for soil landuse,
you will find that there are several sliver polygons in this feature class that have attributes only
from landuse poly and the soil attributes are empty, and vice versa. One way to deal with sliver
polygons is to assign missing values to all features. Another way (easiest!) is to just delete them.

Start the Editor. Select all the features that have “FID ...” = -1 and delete them. Save your edits,
stop the Editor, and save the map document. The next step is to prepare a look-up table that will
have curve numbers for different combinations of land uses and soil groups. In this case, we will
use SCS curve numbers that are available from literature (SCS reports, or SCS tables from text
books). The spatial features in conjunction with the look-up table can then be used to create
curve number grid.

3.6 Creating CN Look up Table

Create a table named “CNLookUp” inside CNSCS.mdb. You can either do this in ArcMap or in
ArcCatalog. The quick and easy way is to use the command line in ArcMap. Once the table is
created create the following fields in it (see Table 2.1 and appendix):

16



1. LUValue (type: short integer)

2. Description (type: text)

3. A (type: short integer)

4. B (type: short integer)

5. C (type: short integer)

6. D (type: short integer)

Now start the Editor to edit the newly created CNLookUp table, and populate it as shown below.

Table 2.1: CN Look Up table

Table i
attributes of CNLookUp
oip LUValue Descriptio A B [ D
0 1 | Water 100 100 100 100
1 2 | Medium Residential a7 72 &1 86
4 3 | Forest 30 58 71 78
5 4 | Agricultural &7 T 83 ar

4 4 0 » M E (0 out of 4 Selected)

{attributes of CHLookUp!

= _— —_—— — —_—

Columns A/B/C/D store curve numbers for corresponding soil groups for each land use
category(LUValue). These numbers are obtained from SCS TR55 (1986). Save the edits and stop
the Editor. Save the map document

3.7 Creating Multidate CN Grids

We will use HEC-GeoHMS to create the curve number grid. Activate the HEC-GeoHMS Project
View toolbar in the same way as ArcHydro toolbar. HEC-GeoHMS uses the merged feature
class and the lookup table (CNLookUp) to create the curve number grid. Theformat and the field
names that we are used in creating the CNLookUp table are consistent with HEC-GeoHMS.
Before we proceed, one final step is to create a field in the merged feature class named
“LandUse” that will have land use category information to link it to CNLookUp table. We
already have this information stored in GRIDCODE field, but HECGeoHMS looks for this
information in LandUse field. So create a field named LandUse (type: short integer), and
populate it by equating it to GRIDCODE.

On the HEC-GeoHMS Project View toolbar, click on Utility=>Create Parameter Grids.. Choose
the lookup parameter as Curve Number (which is default) in the next window, Click OK, and
then select the inputs for the next window as shown below

17
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Input Hydro DEM
| Fil
Input Soil Landuse Polygon

Isoil_landuse

Input Curve Mumber Lookup

I attributes of CHLookUp

Output Curve Mumber Grid
C:USERS\ALLAN\DOCUMENTS\SEMESTER. 21UN\AMALY @

ok || cancel | |Environments... || showHelp>> |

Figure 3.4: Generate CN Grid

Below is an illustration of the resulting grids for the multiple dates

130

[]30.,00000001 - 58

[ 5800000001 - 72

[ 72.00000001 - 7776470588
I 7776470589 - 80.78431373
B 50.78431374 - 86.52352041
I 56.52352942 - 100

Figure 3.5: Illustration of one of the single date CN Grid
Save and exit arcmap

Open another separate arc map Document for the following task on terrain prepocessing.
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4.0 TERRAIN PRE-PROCESSING

The first step in doing any kind of hydrologic modeling involves delineating streams and
watersheds, and getting some basic watershed properties such as area, slope, flow length, stream
network density, etc.

'] Install Arc Hydro on your computer,

[J Open Arc map click the customize menu (Scroll down the list to see “Customize) In the
Customize dialog that appears, check the Archydro Tools box.

L2 |

Customize

Toolbars | Cornmandsl Dpﬁcrns|

|| | Toolbars:

[] 30 Analyst - [ Mew. ..
AGWAZ Toolbar
[] Advanced Editing
[] Animation

[ ApUtilities Delete
[] ArcSean [
[[]coso

[] Context Menus

[7] Data Driven Pages

[ ] Data Frame Tools

[] Distributed Geodatabase

[] Draw -

m

Rename...

Reset...

| Keyboard... || Add from fie... |  Close

Figure 4.1: Customize Arc Hydro tools

You should be able to see an Arc Hydro tools menu added

Terrain Preprocessing ~ Terrain Morphology = Watershed Processing = Attribute Tools = Metwork Tools ~ Aplltilities~ 5. 2 o, =}= 32 ?E B B # Help

Figure 4.2: ArcHydro tools menu

Note: The spatial analyst extension of arcGIS needs to be activated by clicking
Tools—>Extensions..., and checking the box next to Spatial Analyst.
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Hydrological Parameter Estimation (Hec-GeoHMS)

Hydro Data Model
* Terrain processing (DEM, Flowline)
*  Basin processing
s Extraction of physical
characteristics

* Database modeling
* ESRI, POSTGIS, ORACLE etc

¥ Generate
Compute average CN Compute for Hydrological HRES ekt
* foreach sub basin M Parameters and HMS » e Basin Model
s Meteorological
i model
Precipitation data from either; import project
* Rain guage.
s NEXRAD,
s -surface TIN GRID

HEC-GeoHMS

Figure 4.3: Process flow in Hydro data model and HEC GeoHMS

All steps in terrain processing should be carried out in a sequential order, from top to bottom.
All the Pre-processing should be done before basin processing and characterisation. Depending
on the size of the data set difeerent processes can take from a few minutes to upto 1 hour or even
more.

1. DEM Reconditioning

This function modifies a DEM by imposing linear features onto it (burning/fencing).
It is an implementation of the AGREE method developed Center for Research in
Water Resources at the University of Texas at Austin’.

6 http://www.ce.utexas.edu/prof/maidment/GISHYDRO/ferdi/research/agree/agree.html
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The function needs as input a raw DEM and a linear feature class (like the river network)
that both have to be present in the map document.

71 On the ArcHydro toolbar, select Terrain preprocessing ->DEM Manipulation=>
DEM Reconditioning.

[ Select the appropriate Raw DEM and AGREE stream feature (stream). Set the Agree
parameters as shown. You should reduce the Sharp drop/raise parameter to 10 from
its default 1000. The output is a reconditioned Agree DEM (default name
AgreeDEM).

i Bl
Q DEM Recenditicning # - w
Raw DEM i -
AGREE Stream [NHDHDW"HE v]

b AGREE DEM AgreeDEM

Stream buffer (number of cells) B
Smooth dropiraise (DEM Z-unit) 10

Sharp dropiraize (DEM Z-unit) 10|

l‘ | ok | | Hep | | cancel |

Figure 4.4: Dem Reconditioning
Press ok and the agree DEM shall be added in the current map documet
2. Fill sinks

This function fills the sinks in a grid. If cells with higher elevation surround a cell, the
water is trapped in that cell and cannot flow. The Fill Sinks function modifies the
elevation value to eliminate these problems.

71 On the ArcHydro Toolbar, select Terrain Preprocessing—>Data Manipulation>Fill
Sinks.

[l Confirm that the input for DEM is AgreeDEM (or your original DEM if

Reconditioning was not implemented). The output is the Hydro DEM layer, named by
default Fil. This default name can be overwritten.
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Figure 4.5: Fill sinks

Press ok and the fill layer will be added into the map document

3. Flow direction
) This function computes the flow direction for a given grid. The values in the cells
of the flow direction grid indicate the direction of the steepest descent from that
cell.

"1 On the ArcHydro toolbar, select Terrain Preprocessing > Flow Direction

71 Note: confirm that the hydro Dem is Fill and that the default output grid is Fdr
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Figure 4.6: Flow direction
Press ok and the flow direction grid will be added to the map
4. Flow accumulation

This function computes the flow accumulation grid that contains the accumulated number of
cells upstream of a cell, for each cell in the input grid.

1 On the ArcHydro toolbar, select Terrain Preprocessing = Flow Accumulation.

71 Confirm that the input of the Flow Direction Grid is Fdr. The output is the Flow
Accumulation Grid having a default name of Fac that can be overwritten.

[ Q Flow Accumulation wq
: Flow Direction Grid Ei o
Flow Sccumulation Grid Fac
| OK || Help || Cancd |
)

L =

Figure 4.7: Generate Flow acumulation

Press ok and the flow accumulation grid shall be added on the current map document
5. Stream definition

On the ArcHydro toolbar, select Terrain Preprocessing = Stream Definition.

71 Confirm that the input for the Flow Accumulation Grid is Fac. The output is
the Stream Grid named Str, default name that can be overwritten.
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Enter stream threshold to initiate a stream
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2
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Figure 4.8: Stream Definition

A default value is displayed for the river threshold. This value represents 1% of
the maximum flow accumulation: a simple rule of thumb for stream determination
threshold. . However, any other value of threshold can be selected.

A smaller threshold will result in a denser stream network and usually in a greater
number of delineated catchments. Objective methods for the selection of the
stream delineation threshold to derive the highest resolution network

6. Stream segementation

[1This function creates a grid of stream segments that have a unique
identification. Either a segment may be a head segment, or it may be defined
as a segment between two segment junctions. All the cells in a particular
segment have the same grid code that is specific to that segment.

Q Stream Segmentation M

Flow Direction Grid Fdr o
Stream Grid Cir o
Sink \Watershed Grid
Sink Link Grid

Stream Link Gnid Strlnlk

| OK || Help || Cancd |

Figure 4.9: stream Segementation

7. Catchment grid delineation
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This function creates a grid in which each cell carries a value (grid code) indicating to
which catchment the cell belongs. The value corresponds to the value carried by the
stream segment that drains that area, defined in the stream segment link grid

1 On the ArcHydro toolbar, select Terrain Preprocessing —>Catchment Grid
Delineation

1 Confirm that the input to the Flow Direction Grid and Link Grid are Fdr and Lnk
respectively. The output is the Catchment Grid layer. Cat is its default name that
can be overwritten by the user.

i @ Catchment Grid Delineation Lﬂ_:hJ
| Flow Direction Grid Fdr -
i

Link Grid Strlnik -

Catchment Grid Cat

N

"
l [_OK || Help || Cancd | [
| | — J

Figure 4.10: catchment grid Delineation

[] Press OK. Upon successful completion of the process, the Catchment grid Cat is
added to the map.

8. Catchment polygon processing

The three functions Catchment Polygon Processing, Drainage Line Processing and
Adjoint Catchment Processing convert the raster data developed so far to vector format.
The rasters created up to now have all been stored in a folder named Layers. The vector
data will be stored in a feature dataset also named Layers within the geodatabase
associated with the map document. Unless otherwise specified under APULtilities—> Set
Target Locations the geodatabase inherits the name of the map document (terrain.mdb in
this case) and the folder and feature dataset inherit

On the ArcHydro toolbar, select Terrain Preprocessing -> Catchment Polygon
Processing. This function converts a catchment grid into a catchment polygon feature.

Confirm that the input to the Catchment Grid is Cat. The output is the Catchment
polygon feature class, having the default name Catchment that can be overwritten. Their
names from the active data frame which by default is named Layers.
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@ Catchment Polygon Process.. @
Catchment Grid

Catchment Catchment

| OK || Help || Cancel |

Figure 4.11: Catchment Based Processing

[J Press OK. Upon successful completion of the process, the polygon feature class
Catchment is added to the map.

9. Drainage line processing

This function converts the input Stream Link grid into a Drainage Line feature class. Each line in
the feature class carries the identifier of the catchment in which it resides.

1 On the ArcHydro toolbar, select Terrain Preprocessing—>Drainage Line Processing.

{1 Confirm that the input to Link Grid is Lnk and to Flow Direction Grid Fdr. The output
Drainage Line has the default name DrainagelLine that can be overwritten.

- ;
@ Drainage Line Processing w
Stream Link Grid

Flow Direction Grid Fdr

-

Drainage Line DrainageLine
[ OK |[ Help || Cancel |
E . - ]

Figure 4.11: Drainage Line Processing

(] Press OK. Upon successful completion of the process, the linear feature class
DrainageL.ine is added to the map.

10. Adjoint catchment processing

This function generates the aggregated upstream catchments from the Catchment
feature class. For each catchment that is not a head catchment, a polygon representing
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the whole upstream area draining to its inlet point is constructed and stored in a
feature class that has an Adjoint Catchment tag. This feature class is used to speed up
the point delineation process.

71 On the ArcHydro toolbar, select Terrain Preprocessing = Adjoint Catchment
Processing.

(1 Confirm that the inputs to Drainage Line and Catchment are respectively

DrainageLine and Catchment. The output is Adjoint Catchment, with a
default name AdjointCatchment that can be overwritten

& Adjoint Catchment Processing &J

Drainage Line | DrainageLine et |

Catchment | Catchment - |
Adjoint Catchment AdjointCatchment

0K |[ Help |[ Cancel| |l

b S

Figure 4.12: Adjoint Polygon Processing

7] Press OK. Upon successful completion of the process, the polygon feature
class AdjointCatchment is added to the map.

4.2 Terrain perprocessing Using model builder

Alternatively;

You can use model builder
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Figure 4.13: Terrain Processing Model
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5.0 DEVELOPMENT OF GEOHMS MODEL LAYOUT
5.1 Basin Delineation and Characterisation

Open Arc map click the customize menu (Scroll down the list to see “Customize) In the
Customize dialog that appears, check the Hec Geo Hms Tools box.

2 S|

Customize

Toolbars | Commandsl Dpﬁons|

Toolbars:

[] Geodatabase Histary

[ Geometric Metwork Editing
[] Georeferencng Rename...
Geostatistical Analyst
[ Graphics Delete

HEC-GeoHMS H [

>

New...

HEC-GeoRAS Besete:

[ Image Classification

[] Impact Analysis Tools

[ Labeling

[ Layout

Main Menu

[] Map Service Publishing E|

| Keyboard... || Add fromfle... |  Close |

Figure 5.1: Customizing HEC GEO HMS Module in Arc GIS

You should be able to see a Hec Geo HMS tools added

Preprocessing = Project Setup = Basin Processing~ Characteristics = Parameters~ HMS~ Utility~ & 9= gt T~ 2 ‘?’ Help

Figure 5.2: HEC GeoHMS menu
1. Dataset up
Select HMS Project Setup—>Data Management on the HEC-GeoHMS Main View toolbar.

Confirm/define the corresponding map layers in the Data Management window as shown
below:
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Q Data Management.

]
]

Hydro DEM Fil -

Flow Direction Grid
o| Flow Accumulation Grid
' Stream Grid Sir i
Stream Link Grid
Catchment
Adjoint Catchment

Project Point
| s

[ 0K || Help || Cance |

Figure 5.3: Data setup for Geo HMS
Click ok
2. Creating New HMS Project

Click on HMS Project Setup—>[1Start New Project. Confirm ProjectArea for
ProjectArea and ProjectPoint for ProjectPoint, and click OK

o n'
& Start New Project 5

-

Project Area ProjectArea
Project Point Praject Point
| OK || Help || Cance |

Figure 5.6: Create a New HMS project
(Note: For some reason, if you get an error message about accuracy/resolution of the
data, this has to do with tolerances for x,y,m,z coordinates in your spatial coordinates

which you need to fix in ArcCatalog)

This will create ProjectPoint and ProjectArea feature classes. In the next window,
provide the following inputs:
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F R s - b
E Define a New Project M
Project Name san marco - E]
Description GeoHMS SanMarco
Extraction Method Criginal Stream Definition v]
Metadata for Project:

Il Project Data Location

i@ Outside MainView Geodatabase

Target, ChUsers\ALLAN'Documents semester 24N

|
i
'i (") Inside MainView Geodatsbase i

Figure 5.7: Defining New Project

If you click on Extraction Method drop-down menu, you will see another option “A new
threshold” which will delineate streams based on this new threshold for the new project. For now
accept the default original stream definition option. You can write some metadata if you wish,
and finally choose the outside MainView Geodatabase for Project Data Location, and browse to
your working directory where name of choice.mdb is stored. Click OK.

Click OK on the message regarding successful creation of the project. You will see that new
feature classes ProjectArea and ProjectPoint are added to ArcMap’s table of contents. These
feature classes are added to the same geodatabase ,,name of choice“.mdb.

Next Zoom-in to downstream section of the Cedar creek to define the watershed outlet

Select the Add Project Points tool $ on the HEC-GeoHMS Main View toolbar, and click on
the downstream outlet area of the cedar creek to define the outlet point as shown below as red
dot:
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ﬁ Project Points for sanmarco m
i .

Point Name Outlet1

Deescription Outlet

ok | [ Hep | [Cancel |

Figure 5.10: project points

Accept the default Point Name and Description (Outlet), and click OK. This will add a point for
the watershed outlet in the ProjectPoint feature class. Save the map document.

Next, select HMS Project Setup—>Generate Project. This will create a mesh (by delineating
watershed for the outlet in Project Point), and display a message box asking if you want to create
a project for this area as shown below:

Figure 5.9: Watershed and Sub Basin Delineation

Click Yes on the message box. Next, confirm the layer names for the new project (leave default
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names for Subbasin, Project Point, River and BasinHeader), and click OK

[ @ Generate Project = L L-L-’—J
MainViewDEM [MainViewDEM -
Raw DEM RawDEM
Hydro DEM Fil

l Flow Direction Gnd Fdr i
Flow Accumulation Grid Fac

i Stream Grid Str

: Stream Link Grid StrLnk
Catchment Grid Cat
Subbasin Subbasind32
Project Paint ProjectPoint432
River Riverd32

OK || Help || Cancel

I, =

Figure 5.11: Generating the project

This will create a new folder inside your working folder with the name of the project
Ceedarcreek and store all the relevant raster, vector and tabular data inside this folder. The raster
data are stored in a sub folder with the project name (Ceedarcreek) inside Ceedarcreek folder.
All vector and tabular data are stored in Ceedarcreek.mdb. You will also notice that a new data
frame (Ceedarcreek) is added in ArcMap containing data for Ceedarcreek

Save map document
5.2. Merge basins

This process merges two or more adjacent basins into one. Z00m-in to the area marked in the
rectangle below:
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Figure 5.12: Merging basins

Select the 4 adjacent basins (shown above) using the standard select tool 1 . Click on Basin
Processing—> Basin Merge. You will get a message asking to confirm the merging of selected
basins (with basins hatched in background), click Yes. Similarly merge two more sub-basins.

As a result of merging the sub basins is reduced a desired number. Save map document

5.3 CHARACTERIZING AND PARAMETERIZING GEOHMS MODEL

The basin characteristics menu in the HEC-GeoHMS Project View provide tools for extracting
physical characteristics of streams and sub-basins into attribute tables.

1. River Length

This tool computes the length of river segments and stores them in RiverLen field. Select Basin
Characteristics>River Length. Confirm the input River name, and click OK.
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ﬁ, River Length

Input River
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] [ Cancel ] [En'u'irunments... ] [ Show Help == ]

Figure 5.13: River length computation

If you get a message about no units for z-dimension, ignore it. You can check the Slp field in the
input Riverl (or whatever name you have for your input river) feature class is populated. Fields
ElevUP and ElevDS are also populated during this process. Slp = (ElevUP — ElevDS)/RiverLen.

Input Slope Grid ‘—‘ |F‘Ipl..lt S|GF}E Grid

Islupv?_'l. _:! @

Il 1nput subbasin Mo description available

l | Subbasing32 Rl @
«| i i A
| ok || cancel ||Envionments...|| <<tideHelp | | ToolHep |

Figure 5.14: Basin slope

This tool computes average slope for sub-basins using the slope grid and sub-basin polygons.
Add wshslopepct (percent slope for watershed) grid to the map document. Select Basin
Characteristics=>Basin Slope. Confirm the inputs for Subbasin and Slope Grid, and click OK.

After the computations are complete, the BasinSlope field in the input Subbasin feature class is
populated.

2. Longest flow path

This will create a feature class with polyline features that will store the longest flow path for
each sub-basin. Select Basin Characteristics>Longest Flow Path. Confirm the inputs, and
leave the default output name LongestFlowPath unchanged. Click OK.
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Input Raw DEM Longest Flowpath
| RawDEM

Input Flow Direction Grid GeoHMS Basin Slope
[ Far function

Input Subbasin
| Subbasind32
Cutput Longest Flow Path
C:WUsers\ALLAN\Documents\semester 2\UN\sanmarco's @

m | »

|| cancel ||Envionments... || <<tideHep | |  ToolHelp

Figure 5.15: Longest flow path

A new feature class storing longest flow path for each sub-basin is created as shown below. You
may open the attribute table for the longest flow path and examine its attributes

3. Basin Centroid

This will create a Centroid point feature class to store the centroid of each sub-basin. Choose the
default Center of Gravity Method, and click OK.

[ # Basin Centroid e e S

Select Centroid Method Basin Centroid
Center of gravity

Input Subbasin GeoHMS Basin Centriod
| Subbasind32 | @ function

Output Centroid

C:\Users\ALLAN\Documentsisemester 2YUN\sanmarco's @
Input Flow Accumulation Grid (optional)

Input River {optional)

J [ concel

Figure 5.16: Basin Centroid
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(Note: Center of Gravity Method computes the centroid as the center of gravity of the sub basin
if it is located within the sub basin. If the Center of Gravity is outside, it is snapped to the closest
boundary. Longest Flow Path Method computes the centroid as the center of the longest flow
path within the sub basin. The quality of the results by the two methods is a function of the shape
of the sub basin and should be evaluated after they are generated.)

Confirm the input Subbasin, leave the default name for Centroid, and click OK.

A point feature class showing centroid for each sub-basin is added to the map document. As
centroid locations look reasonable, we will accept the center of gravity method results, and
proceed. Save the map document.

4. Basin Centroid Elevation

This will compute the elevation for each centroid point using the underlying DEM. Select Basin
Characteristics[]Centroid Elevation Update. Confirm the input DEM and centroid feature class,
and click OK.

rﬂ Centroid Elevation % & ‘\* l-:"'"EIMLﬁ?‘]

-

Input Raw DEM

| RawDEM | @

m

Input Centroid
(ICentroida3z ~] !
N
4 i} 3
| Ok | | Cancel | |Enuirunments... | | Show Help == | !

Figure 5.17: Centroid elevation

Ignore the message about unit for Z coordinate. After the computations are complete, open the
attribute table of Centroid to examine the Elevation field. The centroid elevation update may be
needed when none of the basin centroid methods (center of gravity or longest flow path) provide
satisfactory results, and it becomes necessary to edit the Centroid feature class and move the
centroids to a more reasonable location manually.

5. Centroidal Flow Path

Select Basin Characteristics=> Centroidal Flow Path. Confirm the inputs, and leave the default
name for output Centroidal Longest Flow Path, and Click OK.

37



-

- -
#, Centroidal Longest Flowpath % Q* E=0Eal X
Input Subbasin -
Subbasin432 B
Input Centroid -
| Centroid432 =1 I |
Input Longest Flow Path - i
| LongestFlowPathd33 | |
Qutput Centroidal Longest Flow Path - I
snmarco.gdblsanmarco \CentroidalLongestFlowPath432 E;-
Fl m 3 |
| 0K | | Cancel | |Environments... I | Show Help == |

Figure 5.18: centroidal longest flow path

This creates a new polyline feature class showing the flow path for each centroid point along
longest flow path as shown below.

Save the map document.
5.4 HMS INPUTS/PARAMETERS

The hydrologic parameters menu in HEC-GeoHMS provides tools to estimate and assign a
number of watershed and stream parameters for use in HMS. These parameters include SCS
curve number, time of concentration, channel routing coefficients, etc.

1. Select HMS Processes

You can specify the methods that HMS should use for transform (rainfall to runoff) and routing
(channel routing) using this function. Of course, this can be modified and/or assigned inside
HMS.

Select Hydrologic Parameters—>Select HMS Processes. Confirm input feature classes for
Subbasin and River, and click OK. Choose SCS for Loss Method (getting excess rainfall from
total rainfall), SCS for Transform Method (for converting excess rainfall to direct runoff), None
for Baseflow Type, and Muskingum for Route Method (channel routing). Click OK.
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Figure 5.19: Select HMS processes

You can open the attribute table of subbasin feature class to see that the subbasin methods are
added to LossMet, TransMet, and BaseMet fields, respectively. The Muskingum method is added
to RouteMet field in the River feature class. You can treat these methods as tentative which can
be changed in HMS model. Save the map document.

2. River Auto Name

This function assigns names to river segments. Select Hydrologic Parameters=>River Auto
Name. Confirm the input feature class for River, and click OK.

-
’% River Auto Name*

Input River
| Riverd32

1 | 1] | ¥

Figure 5.20: Auto naming the river

The Name field in the input River feature class is populated with names that have “R###”
format, where “R” stands for river/reach “###” is an integer

3. Basin Auto Name

This function assigns names to sub-basins. Select Hydrologic Parameters—>Basin Auto Name.
Confirm the input feature class for sub-basin, and click OK.
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Figure 5.21: Autonaming the basin

Like river names, the Name field in the input Subbasin feature class is populated with names that
have “W###” format, where “W” stands for watershed, and “###” is an integer. Save the map
Document.

4. Sub basin Parameters-----computation of average CN Number

Add the Multidate CN GRIDS to the map document generated in section 3 together with the
impervious grid surface for the study area from the hydrologist (if available). Use the the zonal
statistics of the spatial analyst tool to compute average CN number for each sub basin for
respective dates.

AVERAGE BASIN CURVE NUMBERS OF CEDAR CREEK BASIN

Legend

— LorgassFEiowFaT

:' s _kminew

Rverd

Average basin Curve Numbers
[ 7= eszezass- rasaszrary

[ 7= 342074 - 7o4vemson
[ - 47eseas - TasTIsITSS
Il 75-57esaTse - sos e 103

Canographer: Mazimw e alian
Dale25h Juy 2012
Prajection: NAD 1983_UTM Zore 16
Catum: D_Norih Amerkcan 1983

T L 1
L] 4500 2,000 15,000 Masers

[llustration of one of multiple date average basin CN
5. CN Lag Method

The function computes basin lag in hours (weighted time of concentration or time from the
center of mass of excess rainfall hyetograph to the peak of runoff hydrograph) using the NRCS
National Engineering Handbook (1972) curve number method. Select Hydrologic
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Parameters>CN Lag Method. Confirm the inputs for Subbasin and Longest Flow Path, and
Click OK.

[ @ cNLag Co

Subbasin ISubbasin-BZ ot |

Longest Flow Path | Longest Flow Path433 - |

| OK || Help || Cancd |
— )

Figure 5.22: computation of CN lag

The BasinLag field in the subbasin feature class will be populated with numbers that represent
basin lag time in hours. Save the map document.

5.5 FINALIZING GEOHMS MODEL DEVELOPMENT
The HMS menu has tools for creating input files for HEC-HMS.
1. Map to HMS Units

This tool is used to convert units. Click on HMS—>Map to HMS Units. Confirm the input files,
and click OK

(Note: Due to some unknown reasons, if you get an error message at this point saying field
cannot be added to a layer, save the map document, exit ArcMap and open the document, and try
again) In the next window, choose English units (default) from the drop-down menu, and click
OK.

Select unit type for HMS Model @

Select the Unit type for HMS Unit Conversion

[English -] W

| oK | | Hee | | Cancel |

-

After this process is complete, you will see new fields in both River and Subbasin feature classes
that will have fields ending with “ HMS” to indicate these fields store attributes in the specified
HMS units (English in this case). All fields that store lengths and areas will have corresponding
“ HMS?” fields as a result of this conversion.Check Data
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This tool will verify all the input datasets. Select HMS—>Check Data. Confirm the input datasets
to be checked, and click OK. You should get a message after the data check saying the check
data is completed successfully as shown below

EECESET

Datei  Bearbeiten Format  Ansicht 7

HMS Consistency Checking Log

Project: ceedercreek
File Creation Date: 21,/08/2012
File Creation Time: 08:17:55

Checking uniqueness of names ...
Checking River HydroID uniqueness:
end of checking River HydroID uniqueness - all IDs are unique.
Checking River Name unigueness:
End of checking River Name uniqueness - all Names are unique.
Checking Drainage Area HydroID unigueness:
End of checking Drainage Area HydroID uniqueness - all IDs are unique.
checking Drainage Area Name uniqueness:
end of checking Drainage Area Mame unigueness - all Names are unigue.
Checking VIP Name uniqueness:
End of checking VIP Name uniqueness - all Names are unique.

End of checking uniqueness of names.

Checking river containment...
End of checking river containment.

checking centroid..
end of Checking centroid.

checking river’s connectivity...
end of checking river's connectivity.

Checking project points [VIP points]...
Checking VIP Point: outletl x=661200.9871, y=4564805.5794

End of checking point: name=outletl oid=l - No PROBLEM found.
end of checking project points [VIP points].

2. HMS Schematic
This tool creates a GIS representation of the hydrologic system using a schematic network with

basin elements (nodes/links or junctions/edges) and their connectivity. Select HMS->HMS
Schematic. Confirm the inputs, and click OK.
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HMS SCHEMATIC DRAWING
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Two new feature classes HMS Link and HMSNode will be added to the map document. After
the schematic is created, you can get a feel of how this model will look like in HEC-HMS by
toggling/switching between regular and HMS legend. Select HMS->Toggle HMS
Legend>HMS Legend

3. Add Coordinates

This tool attaches geographic coordinates to features in HMSLink and HMSNode feature
classes.This is useful for exporting the schematic to other models or programs without loosing
the geospatial information. Select HMS—->Add Coordinates. Confirm the input files, and click

OK. The geographic coordinates including the “z” coordinate for nodes are stored as
attributes(CanvasX, CanvasY, and Elevation) in HMSLink and HMSNode feature classes.

4. Prepare Data for Model Export

Select HMS—>Prepare Data for Model Export. Confirm the input Subbasin and River files, and
click OK. This function allows preparing subbasin and river features for export.

Basin Model File 55

&

Exporting Basin file

e B e —
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5. Background Map File

Select HMS->Background Map File. This function captures the geographic information (x,y) of
the subbasin boundaries and stream alignments in a text file that can be read and displayed
within HMS. The output file CedarCreek.map (project name with .map extension) is created in
the project folder. Click OK on the process completion message box. You can open this .map file
using Notepad and examine its contents.

( & Background Shape File . [é]
Subbasin | Subbasin - |
River [Rivert -

| OK || Help || Cance |
L = ]

6. Create Basin model File

This function enables creation of basin model file one one the 3 components files of an HMS
project. This is created by accessing ,,basin model file“on the HMS menue of the GeoHMS tool
bar

7. Create Meterology File

This function enable creation of meterological model i.e precipitation model. To createe
meterological model, from the HMS menu click Met Model File> Guage Weights. Be sure to
specify the guage polygon and sub basin file before confirming with ok

8. HMS Project Set-up

This function copies all the project specific files that you have created (.met, .map, and .met) to a
specified directory, and creates a .hms file that will contain information on other files for input to
HMS. Select HMS—>HMS Project Setup. Browse to the directory where you want to store HMS
project files, and click OK.

If a .hms file already exist in that folder, you may get a message asking you to overwrite or not.
After you respond to that message a project file report will be displayed as shown below:
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Select HMS Project Location  C\Users®ALLAN‘\Documents'semester 25UN

Select Basin File C\Users\ALLAN\Documents'semester 2\UN'\Analysis'\ceedercreekcee | &3

Select Met File C\Users\ALLAN'\Documents'semester 2\LN'\Analysis'\ceedercreekcee | &3

Select Gage File C\Users\ALL AN'\Documents'semester 2\UN'\Analysis®ceedercraskcee | S

HMS Run Name un 3

Simulation Start Date Time  11,/04/2007:12:00:00

Simulation End Date Time  04/14/2007-12:00:00

Time Interval (Minutes) v]

| ok | | Help |

This set of files displayed in project report defines the HMS project that you can open and
manipulate in HMS directly without interacting with GIS. Typically, you will have to modify
meteorologic and basin files to reflect field conditions before actually running the HMS model.
Close the report. Save the map document.
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CHAPTER FOUR: HMS MODELLING

6.1 Opening the HMS Model

10vr HYDROLOGICAL MODELLING (HEC-HM5)

“ ET - wo " (i3 - ™ ELE =]

open project/Export Model
inspect models imported
Create control model
Run simulation

Figure 6.1: Process flow for HMS

6.2 HMS Installation
Install Hec HMS 3.5 on your computer

1) Start HEC-HMS 3.5.

2) Click “File -> Open”. Click on “Browse” button and navigate to the .hms file that you
created at the end of exercise 6.

3) Once the project is opened, you should see entries for Basin Models, Meteorological
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Models, Control Specifications, and Time-Series Data HMS folders.

4)

Open the basin model and review its components. Check basin methods and their

characteristics. Verify that the GeoHMS values were correctly loaded into HMS and
make any necessary modifications (HINT — check the units of the lag time for the SCS

transform method).

1))

Add river and subbasin background shape files. Click “View -> Background Maps ...”.

Click on “Add ...” and then navigate to the HMS project directory and add the river and
basin shape files (you have to do it one at the time). Modify “Draw Properties ...” of the
two background layers to make the model look nice.

[— EC-HMS 3.5 [C:\.,-memsr_;m

p| File Edit View Components Parameters Compute Results Tools Help

| DS EBS v ¢

BRI
-1 W260
eI 250
15 W240
Igﬂ w230
@* w220
-1 W210
15 W200
-1 W 190
15 W30

i W170
R

IIFETY

Components

[ Compute | Resuls |

Transform |
14 Subbasin

| Loss

Basin Name: ceederc
Element Name: W250

Initial Abstraction (IN) |0
*Curve Mumber: |80.616

*Impervious (%) |0.0

Q——

Options |

B E e

Gl B

Cutlett

L]

Storm will be adjusted to each subbasin area.
MOTE 20364 Found no parameter problems in meteorologic model “cedarmetorology™.
WARMIMG 20044: Control specifications time interval is greater than duration of maximum intensity.

Precipitation data will be accumulated.

Figure 6.2: Basin model in HMS
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MOTE 10008: Finished opening project “ceedarcr” in directory "C:YUsersVALLAN'Documents\ceedarcr™ at
| time 16Aug2012, 16:14:51,
MOTE 10179: Opened basin model “ceedercreek” at time 16Aug2012, 16:14:55,

N =

Figure 6.3: Components of HMs Model

If you expand the CedarCreek basin in watershed explorer, you will see the list of junctions,
reaches and subbasins. You can click on any reach and see its associated methods. For example,
when you click on a Reach (R##), you will see that Muskingum routing method is associated
with it. Similarly, if you click on a Watershed (W##), you will see SCS Curve Number (for
abstractions) and SCS Unit Hydrograph (for runoff calculations) are associated with it. Again, if
you click on SCS Curve Number, you will see corresponding parameters in the Component
Window as shown below. All this information, which is now independent of GIS, is extracted
from attributes that we created in HEC-GeoHMS.

6.3 Run the HMS Model

2) From “Compute” run “Select Run” and select the simulation run created in the previous
exercise, or click on “Compute Current Run” tool on the toolbar.

3) From HMS “Compute” menu, run “Compute Run” function.
4) Review the log generated by HMS. See if there are any reported problems.
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5)

6)

7)

Fix any problems you might encounter during the model execution. If necessary, go back
to GeoHMS and perform any necessary operations there. Recreate required files after
modifications in GeoHMS have been completed (e.g. recreate the .basin file). If
additional work is done in GeoHMS, close HMS first.

a. Ifyou have made changes in GeoHMS and re-exported some of the files, you will
have to copy them manually into the HMS directory (since those files already
exist in the HMS project directory, they will not be automatically overwritten by
GeoHMNS).

Rerun HMS until a successful run is completed.
a. Go crazy with HMS options.
Review results using any of HMS result visualization tools.

a. For example, select an element in HMS and from “Results” run “Element Graph™.
You should see something like in the following figure. All the results will be
saved in the model .dss file.
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Figure 6.4: Runing the HMS Model for each scene date CNGrid

Sucessive models for different dates

compared and analysed.
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WARNING 41743: Initial abstraction ratio for subbasin "W 1607 is 0.0,
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of satelite imagery are run and varrying results are
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Figure: 7.1 Process flow using Hec RAS (source: Hec Ras user mannual)




Install HEC GeoRAS onto your computer, Open Arc map click the customize menu (Scroll
down the list to see “Customize) In the Customize dialog that appears, check the Hec Geo RAS
Tools box.

-
Customize

A=)

Toolbars | Commands I Dpﬁuns|

Toolbars:

[] GeolCPR Tools - New...
[7] Geocoding
[7] Geodatabase History Rename... |
[] Geometric Metwork Editing
[7] Georeferencing Delete
[ ] Geostatistical Analyst F

[] Graphics ‘= ‘ [
HEC-GeoHMS =
[] Image Classification

[] Impact Analysis Tools

[] Labeling

[[] Layout

Reset...

[Keybuard... ][ Add from file... ][ Close

Figure: 7.2: Customising HEC GeoRAS

You should be able to see a Hec Geo RAS tools menu added

RAS Geometry = RAS Mapping~ ¢ 8 ||| & = < £ ApUtilities~ Help~

Figure: 7.3: GeoRAS Menu
1. Data Set up

The only essential dataset required for HEC-GeoRAS is the terrain data (TIN or DEM).
Additional datasets that may be useful are aerial photograph (s) and land use information. The
Tin or Dem may derived from a contour map. Note: hydraulic modelling requires data with
higher/better resolution as compared to hydrological modelling in HEC Geo HMS

2. Setting up Analysis Environment for HEC-GeoRAS

Using GIS for hydrologic/hydraulic modeling usually involves three steps: 1) preprocessing of
data, 2) model execution, and 3) post-processing/visualization of results. It is common to use a
single map document to handle a single project, but this ends up with too many feature
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classes/layers in a single map. It is then cumbersome to find out which feature classes were used
during pre-processing, and which feature classes contain results for visualization. To avoid this
confusion, HEC-GeoRAS uses separate data frames to organize pre- and post-processing data.

To create a geometry file, you need terrain (elevation) data. Click on Add button in ArcMap,
and browse to baxter tin to add the terrain to the map document. You must have the same
coordinate system for all the data and data frames used for this tutorial (or any GeoRAS project).
Because baxter tin already has a projected coordinate system, it is applied to the
BaxterGeometry data frame. You can check this by right-clicking on the data frame and looking
at its properties.

3. Creating Ras layers

R4S Geu:umetr}r'| RAS Mapping = ¢ % ||| 5F = < & ApUtilities~ He

Create RAS Layers r | Stream Centerline
Layer Setup Bank Lines
Stream Centerline Attributes Bank Points
XS Cut Line Attributes b Flow Path Centerlines
) X5 Cut Lines
Manning's n Values 3
Bridges/Culverts
Levees »
) Ineffective Flow Areas
Ineffective Flow Areas »
) Blocked Obstructions
Blocked Obstructions 3
Landuse Areas
Bridges/Culverts 3 i
9= Levee Alignment
Inline Structures 3 )
Levee Points
Lateral Structures 3 )
Inline Structures
Storage Areas 3
g Lateral Structures
Storage Area Connections 3
Storage Areas
Export RAS data Storage Area Connections
Terrain Tiles 3 Terrain Tiles
Utilities 3 Terrain Split Lines
e

Figure: 7.3: Creating RAS Layers

In the Create All Layers window, accept the default names, and click OK. HEC-GeoRAS creates
a geodatabase in the same folder where the map document is saved, gives the name of the map
document to the geodatabase baxter georas.mdb, in this case), and stores all the feature
classes/RAS layers in this geodatabase.

After creating RAS layers, these are added to the map document with a pre-assigned symbology.
Since these layers are empty, our task is to populate some or all of these layers depending on our
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project needs, and then create a HEC-RAS geometry file.
4. Creating a river centerline

Let us first start with river centerline. The river centerline is used to establish the river reach
network for HEC-RAS. The ceedar creek tin has a river flowing towards the south east as show
below. The river has different tributaries.

Q’ f.]

L
- ..Imw LT
A iy

=

Figure: 7.4: TIN With River network

We will create/digitize one feature for each reach approximately following the center of the
river, and aligned in the direction of flow. Zoom-in to the most upstream part of the ceedar creek
tributaries.

To create the river centerline (in River feature class), start editing, and choose Create New
Feature as the Task, and River as the Target as shown below:

Editor~ [ » | A- Nl X BN E

Figure: 7.5: digitizing centerline of river

Using the Sketch tool (highlighted above), start digitizing the river centerline from upstream to
downstream until you reach the intersection with Tule Creek tributary. To digitize the upper
Baxter River reach, click in the direction of flow and double click when done (at intersection
with Tule Tributary). If you need to pan, click the pan tool, pan through the map and then
continue by clicking the sketch tool (do not double-click until you reach the junction). After
finishing digitizing the upper Baxter Reach, save the edits. Before you start digitizing the Tule
Creek tributary, modify some editing options. Click on Editora Snapping, and check the End box
next to River.
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We are modifying the editing environment because when we digitize the Tule tributary we want
its downstream end coincide with the downstream end of the upper Baxter Reach. Close the
snapping box, and then start digitizing the Tule Tributary from its upstream end towards the
junction with the Baxter River. When you come close to the junction, zoom-in, and you will
notice that the tool will automatically try to snap (or hug!) to the downstream end of the upper
Baxter Reach. Double click at this point to finish digitizing the Tule Tributary. Save edits.
Finally, digitize the lower Baxter reach from junction with the Tule Tributary to the most
downstream end of the Baxter River. Again make sure you snap the starting point with the
common end points of Upper Baxter Reach and Tule Tributary. Save edits, and stop editing.
(Snapping of all the reaches at the junction is necessary for connectivity and creating HEC-RAS
junction so make sure the three reaches are snapped correctly).

After the reaches are digitized, the next task is to name them. Each river in HEC-RAS must have
a unique river name, and each reach within a river must have a unique reach name. We can treat
the main stem of the Baxter River as one river and the Tributary as the second river. To assign
names to reaches, click on Assign RiverCode/ReachCode button to activate it as shown below:

HEC-GeoRAS
RAS Geometry * RAS Mapping },ﬂ Ll & < < & apltilties * Help ~

Assign RiverCodefReachCode

Figure: 7.6: Populate the rive centerline feature class with geometry

With the button active, click on the upper Baxter River reach. You will see the reach will get
selected, invoking the following window:

Assign River and Reach Na |

River |Baude1 River :]

Reach [Upp-ei Reach

0K | Help | Cancel |

Figure.7.7: Assigning river reaches

Assign the River and Reach name as Baxter River and Upper Reach, respectively, and click OK.
Click on the tributary reach, and use Tule Creek and Tributary for River and Reach name,
espectively. For lower Baxter river, use Baxter River and Lower Reach for River and Reach
name, respectively.

Now open the attribute table of River featureclass, and you will see that the information you just
provided on river and reach names is entered as feature attributes as shown below:
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Figure: 7.8: River Attributes

Also note that there are still some unpopulated attributes in the River feature class (FromNode,
ToNode, etc.).

Before we move forward let us make sure that the reaches we just created are connected, and
populate the remaining attributes of the River feature class. Click on RAS Geometry—> Stream

Centerline Attributes=> Topology

*" Create River Topology X|
Stream Centerline Inm j
Terrain TIN | baster_tin =

‘ ok | Hahlﬁamall‘

Figure: 7.9: Creating River Topology

Confirm River for Stream Centerline and baxter tin for Terrian TIN, and click OK. This function
will populate the FromNode and ToNode attribute of the River feature class. Next, click on RAS
Geometry->Stream Centerline Attributes—> Lengths/Stations. This will populate the remaining
attributes. Now open the attribute table for River, and understand the meaning of each attribute.

=10] x|

Shape_Len| HydrolD River Reach | FromMode | ToMode | Arclength| FromSta | ToSta

b 5595 328750 747 |Bacder River |Upper Resch 1 ) #IN 3 481571  BEG7E4
4113857563 755 Tube Creek  |Tributary 3 2 128515 i] 125515
3577 GATTA0 | 762 Bacder River |Lower Reach| 2| 4 481571 | o] 481574

Becard 1] 4] T30 Show[ar Selected | Riecords (0 cut of 3 Selected) Oplions v|

Figure 7.10: populated River attributes

HydrolD is a unique number for a given feature in a geodatabase. The River and Reach attributes
contain unique names for rivers and reaches, respectively. The FromNode and ToNode attributes
define the connectivity between reaches. ArcLength is the actual length of the reach in map
units, and is equal to Shape Length. In HEC-RAS, distances are represented using station
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numbers measured from downstream to upstream. For example, each river has a station number
of zero at the downstream end, and is equal to the length of the river at the upstream end. Since
we have only one reach for Tule Creek tributary the FromSta attribute is zero and the ToSta
attribute is equal to the ArcLength. Since the Baxter River has two reaches, the FromSta attribute
for Upper Reach = ToSta attribute of lower reach, and the ToSta attribute for upper reach is the
sum of ArcLengths for the upper and lower reach. Close the attribute table, and save the map
document.

5. Creating River Banks

Bank lines are used to distinguish the main channel from the overbank floodplain areas.
Information related to bank locations is used to assign different properties for crosssections. For
example, compared to the main channel, overbank areas are assigned higher values of Manning’s
n to account for more roughness caused by vegetation. Creating bank lines is similar to creating
the channel centerline, but there are no specific guideless with regard to line orientation and
connectivity - they can be digitized either along the flow direction or against the flow direction,
or may be continuous or broken.

To create the channel centerline (in Banks feature class), start editing, and choose Create New
Feature as the Task, and Banks as the Target as shown below:

Editor~ | » | Ni.ch» 2 BRI F

Figure: 7.8: creating river banks

Although there are no specific guidelines for digitizing banks, to be consistent, follow these
guidelines: 1) start from the upstream end; 2) looking downstream, digitize the left bank first and
then the right bank.

Digitize banks for all three reaches and save the edits and the map document.
6. Creating the Flowpath Layer

The flowpath layer contains three types of lines: centerline, left overbank, and right overbank.
The flowpath lines are used to determine the downstream reach lengths between cross-sections in
the main channel and over bank areas. If the river centerline that we created earlier lie
approximately in the center of the main channel (which it does), it can be used as the flow path
centerline. Click on RAS Geometry—>Create RAS Layers—=>Flow Path Centerlines Click Yes on
the message box that asks if you want to use the stream centerline to create the flow path
centerline. Confirm River for Stream Centerline and Flowpaths for Flow Path Centerlines, and
click OK.
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To create the left and right flow paths (in Flowpaths feature class), start editing, and choose
Create New Feature as the Task, and Flowpaths as the Target as shown below:

Nlch 2B E

Use the sketch tool to create flowpaths. The left and right flowpaths must be digitized within the
floodplain in the downstream direction. These lines are used to compute distances between
cross-sections in the over bank areas. Again, to be consistent, looking downstream first digitize
the left flowpath followed by the right flowpath for each reach. After digitizing, save the edits
and stop editing. Now label the flowpaths by using the Assign LineType button. Click on the
button (notice the change in cursor), and then click on one of the flow paths (left or right, looking
downstream), and name the flow path accordingly as shown below:

Label all flow paths, and confirm this by opening the attribute table of the Flowpaths feature
class. The LineType field must have data for each row if all flowpaths are labeled.

-10] x|
Shape* ol Shape_Len| LineType
Palyline 13 | 6597 B03BET |Channel
Palyline 15 4133125661 |Channel
Polyline 17 |3035.035827 |Lett
Polyline 193125 636464 |Right
Falylire 20 | 3587 071912 |Channel
Palyline 2210101 15804 |Left
b |Palyline 24 | 1004021602 [Right
Record: 14] 4| 7 2|0 Show| Al Selectedl
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7. Creating cross sections

Cross-sections are one of the key inputs to HEC-RAS. Cross-section cutlines are used to extract
the elevation data from the terrain to create a ground profile across channel flow. The
intersection of cutlines with other RAS layers such as centerline and flow path lines are used to
compute HEC-RAS attributes such as bank stations (locations that separate main channel from
the floodplain), downstream reach lengths (distance between crosssections) and Mannings n.
Therefore, creating adequate number of cross-sections to produce a good representation of
channel bed and floodplain is critical.

Certain guidelines must be followed in creating cross-section cutlines: (1) they are digitized
perpendicular to the direction of flow; (2) must span over the entire flood extent to be modeled;
and (3) always digitized from left to right (looking downstream).

Even though it is not required, but it is a good practice to maintain a consistent spacing between
crosssections. In addition, if you come across a structure (eg. bridge/culvert) along the channel,
make sure you define one cross-section each on the upstream and downstream of this structure.
Structures can be identified by using the aerial photograph provided with the tutorial dataset. For
example, we will use one bridge location in this exercise just downstream of the junction with
tributary as shown below (bridge location is shown in red):

To create cross-section cutlines (in XSCutlines feature class), start editing, and choose Create
New Feature as the Task, and XSCutlines as the Target as shown below:

Editor~ | » | KlN.ch ¥ 2 BN B

Follow the above guidelines and digitize cross-sections using the sketch tool. While digitizing,
make sure that each cross-section is wide enough to cover the floodplain. This can be done using
the cross-sections profile tool. Click on the profile tool, and then click on the cross-section to
view the profile. For example, if you get a cross-section profile shown in Figure A below, then
there is no need to edit the cross-section, but if you get a cross-section as shown in Figure B
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below, then the cross-section needs editing. (Note: This tool stops the edit session so you will
have to start the edit session every time after viewing the cross-section profile).

T 5
] & | @] [T [wTe] | @] 2] el el |l s8] [T ] sl R el @ls] e
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Figure A: adequate definition of cross-section Figure b: inadequate definition of coss-section

After digitizing the cross-sections, save the edits and stop editing. The next step is to add HEC-
RAS attributes to these cutlines. We will add Reach/River name, station number along the
centerline, bank stations and downstream reach lengths. Since all these attributes are based on
the intersection of cross-sections with other layers, make sure each cross-section intersects with
the centerline and overbank flow paths to avoid error messages.

Click on RAS Geometry=> XS Cut Line Attributes=> River/Reach Names. This tool uses the
River and Reach attributes of the centerline, and copy them to the XS Cutlines. Next, click on
RAS Geometry=>XS Cut Line Attributes—=>Stationing. This tool will assign station number
(distance from each cross-section to the downstream end of the river) to each cross-section
cutline. Next, click on RAS Geometry=>XS Cut Line Attributes=> Bank Stations. Confirm
XSCutlines for XS Cut Lines, and Banks for Bank Lines, and click OK.

Station for Bank Lines x|

%5 Cut Lines [#5CutLines |
Banks
(v Bank Lines |Eanks EI
= Bank Poirte |r-1..|| ZI

‘ ok | Hew [

This tool assigns bank stations (distance from the starting point on the XS Cutline to the left and
right bank, looking downstream) to each cross-section cutline. Finally, click on RAS
Geometry—=>XS Cut Line Attributes=>Downstream Reach Lengths. This tool assigns distances to
the next downstream cross-section based on flow paths.

60



The cross-section cutlines are 2D lines with no elevation information associated with them
(Polyline). When you used the profile tool earlier to view the cross-section profile, the program
used the underlying terrain to extract the elevations along the cutline. You can convert 2D
cutlines into 3D by clicking RAS Geometry=>XS Cut Line Attributes—=>Elevation. Confirm
XSCutlines for XS Cut Lines, and baxter tin for Terrian TIN. The new 3D lines (XS Cut Lines
Profiles) will be stored in the XSCutLines3D feature class. Click OK.

Convert 2D X5 Layer to 3D X|

#5 Cut Lines

Terrain TIN | bawter_tin j
%5 Cut Lines Profiles |><El:utLinasEID

#SCutLines

1] 4 | Help | Ean-::ell

After this process is finished, open the attribute table of XSCutLines3D feature class and see that
the shape of this feature class is now PolylineZ.

8. Creating Bridges and Culverts

After creating cross-sections, the next step is to define bridges, culverts and other structure along
the river. Since we used aerial photograph while defining the crosssections, our job of locating
the bridge is done. To create bridges/culverts (in Bridges feature class), start editing, and choose
Create New Feature as the Task, and Bridges as the Target as shown below:

Editor~ | » | KlN.ch ¥ 2 BN B

A bridge or culvert is treated similar to a cross-section so the same criteria used for creating
cross-sections must be used for bridge/culverts. Using the sketch tool on the editor toolbar, the
digitize bridge location just downstream of the tributary junction. While digitizing the bridge,
make use of the terrain model to make sure the bridge/road centerline fall on the high ground.
Save your edits and stop editing.

EE Attributes of Bridges =101 =]
* | shape_Len| HydrolD UsDistance | TopWidth | Nodellame |
369382515 [ 378 Baxter River Lowwer Rea:h_ 10507 & | 40 20 |Raikroad
Recond 14] 4] 1 k| m] ﬁhuw:l All Eeleo\edl Fecords (0 out of 1 Selected.) Optionz =

Close the attribute table, save edits and stop editing.

Similar to cross-sections, the Bridges feature class stores 2D polylines, you can make them 3D
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by clicking RAS Geometry—>Bridge/Culverts—>Elevations to create a new 3DBridges feature
class. Confirm Bridges for Bridges/Culverts, baxter tin for Terrain, Bridges3D for
Bridges/Culverts Profiles, and Click OK.

After digitizing bridges/culverts, you need to assign attributes such as River/Reach name and
station number to these features. Click on RAS Geometry—> Bridge/Culverts—>River/Reach
Names to assign river/reach names. Next click on RAS Geometry—>Bridge/Culverts—> Stationing
to assign station numbers. Besides these attributes, you must enter additional information about
the bridge(s) such as the name and width in its attribute table as shown below.

Convert 2D Bridges,/Culverts La

Bridges/Culverts
Termain | bater_tin j
Eridges/Culverts Profiles |EridgasED

(1] 4 | Help | Ean-::ell

A new feature class (Bridges3D) will be created. You can check it is PolylineZ by opening its
attribute table.

9. Creating ineffective flow areas

Ineffective flow areas are used to identify non-conveyance areas (areas with water but no
flow/zero velocity) of the floodplain. For example, areas behind bridge abutments representing
contraction and expansion zones can be considered as ineffective flow areas. To define
ineffective areas (in IneffAreas feature class), start editing, and choose Create New Feature as
the Task, and IneffAreas as the Target as shown below:

HEC-RAS does not store all information about ineffective areas. Instead only the information
where the ineffective area may interfere with cross-sections/flow is stored. To extract the
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position and elevation at points where these ineffective areas intersect with cross-sections, click
on RAS Geometry—>Ineffective Flow Areas—>Position. Leave the default feature classes for
IneffectiveAreas, XS Cut Lines, and Terrain unchanged. The position of ineffective areas will be
stored in a new table named IneffectivePositions. Leave current user elevations unchecked, and
Click OK.

Ineffective Flow Areas ﬂ

|neffective Areaz

%S Cut Lines [ <5 Cutlines |
Terrain |CEEdﬂr_CrEE|-:TIN EI
Ineffective Positions |InaffactivaF‘nsitinns

[~ Keep cument user elevations

(1] 4 | Help | Ean-::ell

Open the attributes of the IneffectivePositions table (shown below) to understand how this
information is stored.

Ed Attributes of IneffectivePositions =10 x|
OBJECTID* |  %S2DID 1A20I0 | BegFrac | EndFrac | BegElev | EndElev | userblev |
61 77, 362 0| 0583055 7954 555717 |<Muls
H £z 77 362 | 0| 062676 799332 | 67 .54 | MUl
| 63 14| 363 | 0| 03siez 76 | 71 A4 | <ul=
B4 0 363 i 042062 79,54 67 84 |<Hul=
| | 65 eyl B3 i} 0561115 930041 SEOTTT (=hiul=
B 23| 770| O7BOT6| 0974586 | 553637 | 850053 |=Mulks
| 67 713 771 0515738 0811551 SB1B3| 637877 [<Mulls
0 B 20| 771| 055308 0842848 &7.0282) 63 .84 [l
Recod: I1| i ||—E_l|ﬂ| Show: W Selected | Reconds [0 out of B Selectad.) Options '|

IA2DID is the HydroID of the ineffective flow area, XS2DID is the HydroID of the intersecting
cross-section, BeginFrac and EndFrac are the relative positions of the first and last intersecting
points (looking downstream) of the ineffective area with the crosssection. BegElev and EndElev
are the elevations of the first and last intersecting points of the ineffective area with the cross-
section. Since you left the UserElev box unchecked there are no values in this field.

10. Creating Obstructions

Obstructions represent blocked flow areas (areas with no water and no flow). For example,
buildings in the floodplain and levees are considered obstructions. We can add blocked
obstructions to our study by using building locations in the aerial photograph.
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To define blocked obstructions (in BlockedObs feature class), start editing, and choose Create
New Feature as the Task, and BlockedObs as the Target as shown below:

Editor~ | » | KlN.ch ¥ 2 BN B

Use the Sketch tool to define the blocked obstruction, save edits and stop editing. Similar to
Ineffective flow areas, the positions and elevations of the intersection of this obstruction with
cross-sections needs to be stored in a table. Click on RAS GeometryaBlocked Obstructionsa
Positions. Leave the default values in the Blocked Obstructions window, and click OK. You will
notice that a new table (BlockedPositions) will be added to the map document, and its content
are identical to IneffectivePositions table

11. Assigning Manning’s n to cross-sections

The final task before exporting the GIS data to HEC-RAS geometry file is assigning Manning’s
n value to individual cross-sections. In HEC-GeoRAS, this is accomplished by using a land use
feature class with Manning’s n stored for different land use types. Ideally you will store this
information in the LandUse feature class added to the map .
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=10] x|

Shape* olp* Shape_Len| Shape_Area LUCode H_Value -
Palygon 85 (74238 03096 | 47554074 26450 [Mearstream 0035
Palygon 86 | 94595 33653 | Y7091525 352458 |Mearstream 0035
Palygon 87 119499 6577 | 3390744 917055 |Mearstream 0,035
Palygon 88 (25155 89047 | 37360769 BE2E6S [Urban 0055
Palygon 89 (5747077954 | 132069468 0426 [Farming 006
Palygon a0 (43729 468224 | 8021091473519 [Urban 0,085
Palygon 91 | 49495 57930 [ 131147302 0762 | Urban 0,055
Palygon 92 (98679 54404 | SEE3E51 7T 0998 [Farming 006
Palygon 93 (1394808173 | 562045502 7971 [Farming 0.06
Palygon 94 (77954 85364 | 194373174 0636 |Urban 0.055
Palygon 95 (74511 .02607 | 8534221781712 |Farming 0.06
Palygon 96 | 88235 01037 | 333565959.4000 (Farming 0.06
Palygon a7 [30673.045829 | 44559471 00346 |Urban 0.055

Dalvarimm a2 | TATASE TRATE | ANE22E22 N34T | vbhan nnss LI
Recaord: illll 15 _Plﬂl Show; IW Selected | Records [0 out of 90 Selected.]

The land use table must have a descriptive field identifying landuse type, which is LUCode in
this case, and a field for corresponding Manning’s n values. In addition, HEC-GeoRAS requires
the land use polygons to be non multi-part features (a multipart feature has multiple geometries
in the same feature). The issue of non multi-part features is taken care of for the tutorial dataset.

To assign Manning’s n to cross-sections, click on RAS Geometry->Manning’s n
Values—>Extract n Values. Confirm LandUse for Land Use, choose N Value for Manning Field,
XSCutLines for XS Cut Lines, leave the default name Manning for XS Manning Table, and click
OK. (Note: Summary Manning Table is not required if n values already exist in the LandUse
table.).

x
Land Use |Landl.lse ﬂ
bManning Option
+ Marring Field [N_Value =
. Summary Manning Table |'].| _ﬂ
5 Cut Lines | S Tutlines =
#5 Manning Table [Marring

oK | Help ] Cancol |

Depending on the intersection of cross-sections with landuse polygons, Manning’s n are
extracted for each cross-section, and reported in the XS Manning Table (Manning). Open the
Manning table, and see how the values are stored. Similar to previous tables, the data are
organized as the feature identifier (XS2DID), its relative station number and the corresponding n
value as shown below:
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B3 Attributes of Manning

=10l x|

OBJECTID* X52DID Fraction H_Value
L 1 325 0 0.05
2 325 015866 0.035
3 325 0.89530 0.05
4 326 1 0.06
5 326 057385 0.03s
B 326 0.53049 0.05
v 327 1 0.06

Record: il LII 1

_Plﬂl Shu:uw:l Al Selected | Records [0 out of 505 Selected. ]

=

Close the table. We are almost done with GeoRAS pre-processing. The last step is to create a
GIS import file for HEC-RAS so that it can import the GIS data to create the geometry file.
Before creating an import file, make sure we are exporting the right layers. Click on RAS
Geometry—> Layer Setup, and verify the layers in each tab. The required surface tab should have
baxter tin for single Terrain option.

{+ Singla

£ Multiple

Terain Type

Select Terrain

DT Tiles Layet

& TIN (" Grid

| ceedarcreekTIN

=

[l

=]

The Required Layers tab should have River, XSCutLines and XSCutLines3D for Stream
Centerline, XSCutmLines and XSCut Lines Profiles, respectively.

x

Strearn Cantatline
#5 Cut Lines

| River

=l

[ %S CutLines

=~

#5 Cut Lines Profiles |><SEutLinesSD

=~

In the Optional Layers tab, make sure the layers that are empty are set to Null
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x

Required Suface | Fiequired Layers Optional Layers | Optional Tables |

Bank Lines | Banks Stream Profiles [Nl =
Flows Path Centerlines | Flowpaths Storage Areas | MNull j
Land Use | Landlse Storage Points | Nl =
Levee Alignment INuII Levees Profiles | Hull -

Leves Points

|

Ineffective Flow Sreas Ilnaffﬁraas

Blacked Obstructions | BlockedObs

Led Lef L Lo Led L f e Led L Lo

Bridges/Culverts | Bridges Bridges/Culverts Profiles | Bridges3D =]
Inline Structures f Nuil Inine Stuctures Profiles | Null =]
Lateral Structures f Nul Lateral Structures Profiles | Null |
54 Connections | Barks SA Connections Profiles [ Null =
[~ fpply HEC-GeoRasS Symbaology (114 | Help | Cancel

Finally, verify the tables and Click OK.

Required Surfacel Required La_l,lersl Optional Layers | Optional Tab"?SE

M ariring | anning j
Leves Positions | Hull 3
Ineffective Areas | IneffectivePositions j
Blocked Obstructions | BlockedPosiions ¥ |
Elevation Yolume | Ml j
Nodes Table [u =l

After verifying all layers and tables, click on RAS Geometry[|Export GIS Data.

X

File Mame |ng"v. ALLAN “GeoR as\TutorialhGlS 2RAS| EI

‘ (1] 4 | Help | Eancull‘

Confirm the location and the name of the export file (GIS2RAS in this case), and click OK. This
process will create two files: GIS2RAS.xml and GIS2RAS.RASImport.sdf. Click OK on the
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series of messages about computing times. You are done exporting the GIS data! The next step is
to import these data into a HEC-RAS model. Save the map document. You can either close the
ArcMap session or leave it running.

12. Importing Geometry data into HEC-RAS

Launch HEC-RAS by clicking on Start=>Programs>HEC->HEC-RAS->HEC-RAS 4.0.Save
the new project by going to File=>Save Project As.. and save as creek.prj in your working folder
as shown below: Entering Flow Data and Boundary Conditions

Save Project As

Tithe File Mame
| flood study for creek River | creek.pr)
Click OK.

To import the GIS data into HEC-RAS, first go to geometric data editor by clicking on
Edit>Geometric Data... In the geometric data editor, click on File>Import Geometry
Data—>GIS Format. Browse to creekRAS.RASImport.sdf file created in GIS, and click OK. The
import process will ask for your inputs to complete. In the Intro tab, confirm US Customary
Units for Import data as and click Next.

Current RAS project unite: [ IS Custarnary Lrits

Import data as: & 115 Customan arits
51 [metric] units

Irmpart data will hot be converted ok impart.

Confirm the River/Reach data, make sure all import stream lines boxes are checked, and click
Next

Confirm cross-sections data, make sure all Import Data boxes are checked for crosssections, and
click OK (accept default values for matching tolerance, round places, etc).

Since we do not have Storage areas, click Finished-Import Data. The data will then be imported
to the HEC-RAS geometric editor as shown below:
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Save the geometry file by clicking File>Save Geometry Data. Before you proceed, it is a good
practice to perform a quality check on the data to make sure no erroneous information is
imported from GIS. You can use the tools in Geometric editor to perform the quality check. One
of the best tools for editing cross-sections in HEC-RAS is the graphical cross-section editor. In
the geometric editor, go to Tools—=> Graphical Crosssection Edit.

| Grophcxsedtor ~1oj x|
Fils  Ciptions
Fiver, [Baser Rivar Bl I™ Persisterd Scae
Fieach |Lower Reach =] As: MH,'J [~ Compaes Geometnp Files
Description | ™ Memge Cross Seclions:
Bk Staton Tecke _'-"|£| t_l’Iﬁi b [ @-
- *I I:E—“i =
909 Lagurl
—a
&7 ':m::nu
Bank Stn
g ™
[
f
i
b
40
a0 T . .
0 500 1000 1500 00 24010
Sation (f) B
] A )
[Mave Objects

You can use the editor to move bank stations, change the distribution of Manning’s
n,add/move/delete ground points, edit structure, etc. You can play around with these tools and
learn more about the functions.

A cross-section in HEC-RAS can have up to 500 elevation points. Generally these many points
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are not required, and also when we extract cross-sections from a terrain using HEC-GeoRAS, we
get a lot of redundant points. This issue can be handled by using the cross-section filter in HEC-
RAS. In the Geometric data editor, click on Tools—=>Cross Section Points Filter.

In the Cross Section Point Filter, select the Multiple Locations tab. From the River drop down
menu, select (All Rivers) option, and click on the select arrow button to select all cross-sections
for all reaches. Then select the Minimize Area Change tab at the bottom, and enter 250 for the
number of points to trim cross-sections down to. The minimize area change will reduce the
impact of change in cross-sectional area as a result of points removal. Click Filter Points on
Selected XS button.

Cross Section Point Filter _ |0l x|

Simgle Location  Multiple Locations ]

Selected Locations [172 zelected)
Elfver |[g|||:|iver$] ﬂ Baster River Upper Reach 9561054 ﬂ
Baster Arver  Upper Reach 9473274
Reach: | ~||BasterRiver UpperReach 9433326
: : Baxter Aver  Upper Reach  94151.10
River Sta.: |[All Rivers] Baster River UpperReach 9375342

Baster Aiver Upper Reach  93334.83
j Baxter Rrver  Upper Reach 9274622
Baster Aiver Upper Reach  92554.42
Baxter Rrver  Upper Reach  92085.68
Bawter Bver Upper Reach  91751.10
Baxter Rrver  Upper Reach 9146256
Bawter Arver Upper Reach 9120593
Baxter Brver  Upper Reach 9041075
Bawter Aver  Upper Reach 89926 41
Baxter Rrver  Upper Reach 8350326
Bawter Aver Upper Reach  89033.53
Baxter Rrver  Upper Reach 88752 54
Bawter Arver  Upper Reach 8811067 ;I

Mear and Colinear Filker  Minimize Area Change I

Mumber of points to tim cross section down bo: |25|] Filter Paints an Selected =5 |

HestDrEXSl Ok I Cancel I

|E niker the target for poink reduction procedure.

You will get a summary of number of points removed for the filtered cross-sections. You will
notice that only a few cross-sections had points removal. Close the summary results box. You
can select the Single Location tab to see the effect of points removal on the cross-sections.

Another main task that we want to do is to edit data related to structures. Since we have only one
bridge, we will edit its information because details such as deck elevation and number of piers
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are usually not exported by HEC-GeoRAS. Click on Bridge/Culvert

Birdig/Cul,
editing button =-, and select the Railroad bridge on the Lower Reach of the Baxter

River.

River; |Eaﬂtar Riser _ﬂ Soply Data | + “l

v | River Sta.: [780.6202 Rairo v | §]

You will see that the deck elevation is not complete. The bridge does not even cross the river in
this case! So we will edit this information.

Reach: |{Rl=lal=r

Bridge Culvert Data - Baster Geninelry E, =]

Ble e Qpisors  Help

RArees: l!mﬂml 'I | l-l--
Fleach =] Pover s [FE0ERD Rain =] 4] ¥
Descegtion | =]
Bounding ®5c M]Mmmmmm
BT ] & FS=TBIEMN Radroadysiream (Eridge) - =
S . + Lo
=12 mn . Orund
l E E’ s insdi
5 *
Sioping] & 2 Bank Sln
L
g 1000 20 2000 4000
ol
A h & RE=T80 207 AskpadDowsiresn. (Sridge)
Cubaen | b + ’—l
L = NS
Malei] § W@
0
HTak = -
Pasirt q 1m0 2mg 0 4000
Station (1) 7
o —— o
Cesign !
Fisiocihe Fooch o Biche/ Lo E g |

Click on Deck/Roadway editor, and delete all information (you can select the Cells and press
Delete on the key board similar to an Excel operation). We will approximate the bridge width to
about 1200 ft (station 2200 to 3400), deck elevation as 84 ft (high chord) and 6ft deep (low
chord) as shown below:
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Deck Roadway Data Editor
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E DT 78 2 B 78
4300, 84, 78 M0 B4 78
kLT 11 R
M0 A o B

-

115 Embarkment 55 |0 [.5 Embarkmert 55 FIZI

Weil Data i
Max Submengence: D95 Iy ‘et Flowsr EL f
‘Wi Ciast Shape
{® Brosd Crested
- Ogee
ok | cawel | Cesw | Copuswps |
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Click on the Copy US to DS button to copy the information from upstream to downstream, and
click OK. Next, we will enter pier information. We will assume twelve 10 ft wide piers with a
spacing of 100 ft. Click on Bridge Design button , and enter

the information as shown below:

Bridge Design Editor

— Deck/Roadway

El af High Chaord [Top of Road) I
El of Low Chord |
[T Add Wertical Walls in Deck

Opening ‘Width [Blank far Ehan]l
[T Add Sloping Abutments

Side Slope | H:1y

Make Deck/Roadway |
~ Piers
Murnber of Piers |1 2
Ipstrearn ¥5 Starting Statian |225E|
Dawnstream %5 Starting Station |225IZI

Fier Centerline Spacing 100
Pier ‘width |1 0
Make Piers |

Cloze I

Click on Make Piers, and then click Close. The bridge should now look similar to the figure
shown below:
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You need to know the actual bridge condition to be able to accurately enter this information, but
for this tutorial we have used our intuition (and creativity!) in designing

the bridge. After you are done editing the bridge data, close the bridge/culvert editor, save
geometry data and close the geometric editor. We are done with geometric data! The next step is
to enter flow data. For this tutorial we will run the model in steady state condition

13. Entering Flow data and boundary conditions

Flows are typically defined at the most upstream location of each river/tributary, and at
junctions. There are situations where you need to define flows at additional locations, but for this
tutorial we will use the typical case. Each flow that needs to be simulated is called a profile in
HEC-RAS. For this exercise, we will create three hypothetical profiles. In the main HEC-RAS
window, click on Edit[Steady Flow Data. Enter 3 for number of profiles, and click Apply Data.
Enter hypothetical flow conditions for these profiles as shown below:
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Steady Flow Data - Baxter flow file - 10| x|

File ©Options Help
Enter/Edit Mumber of Profiles (2000 max] |3 Reach Boundary Conditions | Apply Data |

Locations of Flow Data Chanoes
River, |Baster River ~|
Reach: |Llppai Reach ;l River 5ta.:|9?925]1 ﬂ Add & Flow Change Location |
River Reach RS PF1 PF2

96000
100000

B ater River Upper Aeach | 9792.901 24000 48000
B ater River 3114.647| 25000 50000
Tule Creek, 2000

—_

|E dit Steady flow data for the profiles [cfz]

The flow conditions defined in the above window are upstream conditions. To define
downstream boundary, click on Reach Boundary Conditions. Then select Downstreamfor Baxter
River Lower Reach, click on Normal Depth, and enter 0.001.

Steady Flow Boundary Conditions
% Set boundary for all profles " Set boundary for one praofile at a time

Avvalable External Boundary Condtion Types

Sleady Elow Beach-Storage Are s Hptimization ... I 0K I Cancel I Help I

|Enter bo make the boundary for selected locabion nomal depth,

Click OK. Save the flow data (give whatever title you like), and close the Steady Flow editor.
Now we are ready to run HEC-RAS!

7.2 RUNNING HEC-RAS

In the main HEC-RAS window, click on Run—>Steady Flow Analysis..
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File Cptions Help
Plan ; |F'Ian m Short 1D IF'Ian )|
Geometry Fils : [B auter Geometry :]
Steady Flow File : | Baster flow fle =l
Flow Regime Flan Description
# Suberitical | El
" Supercritical
™ Mixed
COMPUTE |
| |

Select the Subcritical Flow Regime, and click on the COMPUTE button. (Note: If you get an
geometry or flow data based on error messages to run the

error, you will need to modify
simulation successfully).

HEC-RAS Finished Computations o ] |
— Steady Flow Simulation
River: Baxter River RS: 9732.90
Reach: |Ipper Reach Mode Type:  Crosz Section
Frofle:  PF 3 |
Simuation: 3/3 ey

Computation Meszages

Steady Flow Simulation Version 3.1.3 May 2008
Finighed Steady Flow Simulation

Tatal Computation Tirme = O min 0.43 sec

After successful simulation, close the computation window and the steady flow window.We will
now export HEC-RAS results to ArcGIS to view the inundation extent, but before this step, you
should look at the output results and verify them in HEC-RAS. This will help identify any errors
in the input data and fix them, and run the simulation again, if necessary.

7.3 Exporing HEC-RAS Output

To export the data to ArcGIS click on File[JExport GIS Data... in the main HEC-RAS window.
Since we ran the model with three profiles, we can choose which profile we would like to export.
Click on Select Profiles to Export button, and choose the profile you want to export. For this
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exercise we will choose the one with maximum flow (PF3), and accept the default export
options.

Ewpost File: |kh;|WEﬂkatesh"J3 eoF as\T utonialvbawter RASexport.sdf | Browse .., |
— Resultz Export Optionz
¥ Ewport\water Sufaces Select Profles to Export I

Prafiles to

E spout:

™ Expart Velaciy Distibution Information where available.

[ Use verzion 2 2 expart fomat

— Geomety [ ata Export Opfions
[¥ Ewport River [Stream) Centerfines

Addtional Properties

[~ Ewport Uszer Defned Crozs Sechons [T Reach Lengths

Crozs Sechon Suface Lines

[all 5"z except Intespolated X5z I Bark Stations
[T Export Interpolated Cross S ections I | erees
+ Entire Crosz Sechan [ Ineffective Areas
" Channel anly [ Blocked Obstructions
Export Data I Cancel Help I

7.4 Flood inundation mapping

In ArcMap (if you closed baxter_georas.mxd earlier, open it) click on Import RAS SDFfile

button & to convert the SDF file into an XML file. In the Convert RAS Output ASCII File to
XML window, browse to Baxter.RASexport.sdf, and click OK. The XML file will be saved with
the input file name in the same folder with an xml extension

X
RAS Dutput File; |nkateah\ﬁeoﬁa@‘ﬂttmﬁ'\hmder.H.&Sexpnrt.sdﬂ [ﬁ.""l
#ML File: |k atesh\GeoR as\T utorial\baxter RAS export xmi

oK Help Cancel

Now click on RAS Mapping[] Layer Setup to open the post processing layer menu as shown
below:
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Layer Setup for HEC-RAS PostProcessing ﬂ

— Analyziz Type
(" Existing Analysis | |
* Mew Analysis |Steady Flow

R&S GIS Export File IkingW&Malesh\ﬁeﬂﬂasﬂduid\baxter.H.&Sexpnrt.Hml ﬂ

— Tarrain
& S Terain Type  Select Tenain
* SN3® @ TN C Gid IkﬁeoﬁasKDdakBmmTsrrain"-.baatar_tin ﬂ
" Multiple | DTM Tiles Layer | El

Cuitput Directany |E:\Wn|khg'\ﬂrkmhkﬁeunﬂa¢ﬂm5hudy Flow Q"I
Output GeoDatabase  |Steady Flow.mdb

R asterization Cell Size |2|:| [map units]

ok | Help Cancel |

In the layer setup for post-processing, first select the New Analysis option, and name the new
analysis as Steady Flow. Browse to Baxter..RASexport.xml for RAS GIS Export File. Select the
Single Terrain Type, and browse to baxter tin. Browse to your working folder for Output
Directory. HEC-GeoRAS will create a geodatabase with the analysis name (Steady Flow) in your
output directory. Accept the default 20 map units for Rasterization Cell Size. Click OK. A new
map (data frame) with the analysis name (Steady Flow) will be added to ArcMap with the terrain
data. At this stage the terrain TIN (baxter tin) is also converted to a digital elevation model
(DEM) and saved in the working folder (Steady Flow) as dtmgrid. The cell size of dtmgrid is
equal to the Rasterization Cell Size you chose in the layer setup window.

Next click on RAS Mapping-> Read RAS GIS Export File. This will create a bounding polygon,
which basically defines the analysis extent for inundation mapping, by connecting the endpoints
of XS Cut Lines.
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After the analysis extent is defined, we are ready to map the inundation extent. Click on RAS
Mapping[Inundation Mapping[] Water Surface Generation. Select PF3 (profile with highest
flow), and click OK.

i water surface TIN x|

S elect water surface profile:
‘ Help |
_Corcel |

This will create a surface with water surface elevation for the selected profile. The TIN (tP003)
that is created in this step will define a zone that will connect the outer points of the bounding
polygon, which means the TIN will include area outside the possible inundation.

At this point we have a water surface (tP003) TIN, and we have an underlying terrain (baxter tin
and dtmgrid). Now we will subtract the terrain (dtmgrid) from the water surface TIN, by first
converting the water surface TIN to a grid. Click on RAS Mappingl[JInundation
Mapping[/Floodplain Delineation. Again, select PF3 (profile with highest flow), and click OK.
At this stage the water surface TIN (tP003) is first converted to a GRID, and then dtmgrid is
subtracted from the water surface grid. The area with positive results (meaning water surface is
higher than the terrain) is flood area, and the area with negative results is dry. All the cells in
water surface grid that result in positive values after subtraction are converted to a polygon,
which is the final flood inundation polygon.
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Inundation Polygon

After the inundation map is created, you must check the inundation polygon for its quality. You
will have to look at the inundation map and the underlying terrain to correct errors in the flood
inundation polygon. Sometimes you will realize (at the end!) that your terrain has errors, which
you need to fix in the HEC-RAS geometry file. The refinement of flood inundation results to
create a hydraulically correct output is not covered in this tutorial - this is an iterative process
requiring several iterations between GIS and HECRAS. The ability to judge the quality of terrain
and flood inundation polygon comes with the knowledge of the study area and experience

Save the ArcMap document. Congratulations, you have successfully finished the HECGeoRAS
tutorial!
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